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Microsoft Word Tips & Tricks 
 
Quick Selection 
By holding down the shift key while using one of the navigational shortcut keys (this 
trick should work in conjunction with most of them), Word will select the text (and other 
objects0 as you navigate past it. 
You can also use it with the mouse. Click at the beginning of the text block you wish to 
select and hold the shift key when you click at the end of the block of text you wish to 
select. 
 
 
Return to a Previous Editing Location: 
the Shift + F5 shortcut key remembers the last 3 places you entered or changed text, 
and can make your work a lot easier when you need to move around Word. 
 
 
Unprotecting a document when you don’t know the password. 
Open the document and do a File > Save As. In the dropdown box called “Save As 
Type” choose Word 6.0/95. Then save it somewhere other than saving over your 
document. After the save is complete, close the word document. Reopen the document 
you just saved. Go to Tools > Unprotect Document and voila, it won’t ask for a 
password! 
 
 
First Page Different from Others 
If you have a footer or header on the first page that isn’t showing up on any other page, 
or vice-versa, it may be that you have “different first page” selected. Click on  File, then 
Page Setup, then Layout, and uncheck “different first page.” 
 
 
Header/Footer not Showing! 
This may simply be your view selection. Click “View” and select “Print Layout” 
 
 
Orphan Headers 
To avoid a header at the bottom of a page and the text on the next page (this is called 
an orphan header): 

1. Highlight the text 
2. Right click 
3. Select ‘paragraph’ 
4. Select  Line and Page Breaks and 
5. Check ‘widow/orphan control’ 
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Quick Text Formatting 
If you want to change all of a particular type of text in a document, such as section 
headers: 

1. Highlight one header and double click on the paintbrush tool (on the formatting 
toolbar). This will change your cursor into a paintbrush. If you only want to format 
one section rather than several different ones, click only once on the paintbrush 
instead of double clicking  

2. Click and drag your cursor over the text you want to change.  
3. When you are done with formatting all of the words you want to format in the 

document, click on the paintbrush again. (If you had only clicked once on the 
paintbrush in step one, you won’t need to perform this final step). 

 
 
Adding terms to your Custom Dictionary 
If you have typed a word that is flagged as a spelling error, simply right click on the word 
and select Add to Dictionary from the shortcut menu. The word will be added to your 
custom dictionary. If you haven’t created a custom dictionary, a new one will be created 
for you (the default name for dictionaries created with this method is CUSTOM.dic). 
 
 
Show/Hide Placeholders 
If you want to see where your new paragraphs, indents, spaces, etc. are, click on the ¶ 
icon in the formatting toolbar. Spaces are marked with a period between words, 
paragraphs are marked exactly like the icon an soft returns are marked with an arrow. 
This can help you with formatting issues as well and to show you where section breaks 
and page breaks may be located. 
 
 
 
Inserting a Date Field in Your Document 
This will change the date/time every time the document is opened. To insert a date field 
in your document, follow these steps: 

1. Position the cursor where you would like to place the field 
2. From the Insert menu, select Field… 
3. In the Field dialog box, select Date in the Field names: scroll box 
4. In the Date formats: box, select the date format that best suits the context of 

your document 
5. Click OK 

The date field will be inserted in your document in the format you selected. Each time 
you open the document or use the F9 key to update fields, the date will be updated.  
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Inserting a New Line in a Bullet Paragraph Without Making a New Bullet 
If you would like to create a second line under a line in bullet format without creating a 
new bullet, you need a ‘soft return.’ To create a soft return, click ‘shift’ and ‘enter’ at the 
same time. 
 
 
Changing the Location Where Files Are Saved 
Word will default saving a new document to your My Documents folder. To change this 
default:  

1. From the Tools menu select Options 
2. In the dialog box that appears, click the File Locations tab 
3. In the box under File Types select the type of file by clicking its name (Word files 

are Documents 
4. Click the Modify button. 
5. When the Modify Location dialog box appears find the folder where you would 

like Word to store saved documents by navigating through the folders as you 
would in the Save dialog box. 

6. Click “OK” 
 
 
Opening up a previous word document. 
The last four word documents you opened are still cached in Word’s memory. To open 
a previous document quickly when you have word open, go to File – toward the bottom 
of the drop down list that appears are the last documents you opened. 
 
 
Drag and Drop Copying and Moving 
To Move Text or objects Using the Mouse: 

1. Highlight the portion of the document you wish to move 
2. Click on the highlighted text and, holding the mouse key, drag it to the new place 

in your document 
3. Release the mouse key 

 
To Copy Text Using the Mouse: 

1. Highlight the portion of the document you wish to copy 
2. Click on the highlighted text with the right mouse key and hold it as you drag the 

text to the new place in your document 
3. When you release the mouse key, select Copy from the pop up menu 

 
While Word is quite good at fixing the spacing when you copy and move using this 
method, it is still a good idea to check both locations in your document to make sure the 
spacing is correct 
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Commonly used keyboard combinations 
To use one of these combinations Hold the Ctrl or Alt key down  

and strike the letter key 

Ctrl+N  
Open a new word document 
quickly. 

Ctrl+X 

Cut- Removes the selection from 
the active document and places it 
on the clipboard. 

Ctrl+O  
Opens a previously saved 
document. 

Ctrl+C  Copies the selection to the clipboard

Ctrl+W  
Closes the active window, but 
does not Exit Word. 

Ctrl+V  

Paste - Inserts the contents of the 
clipboard at the insertion point 
(cursor) or whatever is selected. 

Ctrl+S  

Saves the active document with 
its current file name, location 
and format. 

Ctrl+A  
Selects all text and graphics in the 
active window. 

Ctrl+P  

Prints the active file, also gives 
the opportunity to change print 
options 

Ctrl+F  
Find - Searches for specified text in 
the active document 

Alt+F4  Exit - Closes Microsoft Word. Ctrl+B  
Bold - Formats selected text; make 
text bold, or remove bold formatting 

Ctrl+Z  

Undo the last action. This 
selection can be repeated 
several times. 

Ctrl+I  
Italic - Formats selected text; make 
text italic or remove italic 

Ctrl+Y  

Redo - After an action has been 
undone, it can be reinstated in 
the document. 

Ctrl+U  

Underline - Formats selected text; 
make text underlined or remove 
underline 
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Less commonly used keyboard combinations 
 

 
Increase selected text 
two points 

Apply superscript 
formatting 

 
Decrease selected text 
two points 

Apply subscript formatting 

 
Increase selected text 
one point 

Copy formats 

 
Decrease selected text 
one point 

Paste formats 

 
Change case of the 
letters 

Single space lines 

 
Underline words but not 
spaces 

Set 1.5 line spacing 

 Double underline text Double space lines 

 Center a paragraph Delete one word to the left 

 Justify a paragraph 
Delete one word to the 
right 

 Left align a paragraph Right align a paragraph 

 
Indent a paragraph from 
the left 

Insert a line break 

 Create a hanging indent Reduce a hanging indent 

 
If text is already selected and you want to extend the selection 

area  

 
Extend selection one 
character to the left 

Extend selection one 
character to the right 

 
Extend selection to the 
end of a word 

Extend selection to the 
beginning of a word 

 
If you want to move the cursor  

 
One character to the 
right 

One character to the left 

 One word to the right One word to the left 

 
To the end of a 
document 

To the beginning of a 
document 
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Microsoft Word Shortcut Keys- Comprehensive 
Click a heading name one time, to sort by that column! 

Category  Description  Keystrokes  

Align Paras Center a paragraph CTRL+E 

Align Paras Create a hanging indent CTRL+T 

Align Paras Indent a paragraph from the left CTRL+M 

Align Paras Justify a paragraph CTRL+J 

Align Paras Left align a paragraph CTRL+L 

Align Paras Reduce a hanging indent CTRL+SHIFT+T 

Align Paras Remove a paragraph indent from the 
left 

CTRL+SHIFT+M 

Align Paras Remove paragraph formatting CTRL+Q 

Align Paras Right align a paragraph CTRL+R 

AutoText Create an AutoText entry ALT+F3 

Bookmarks Edit a bookmark CTRL+SHIFT+F5 

Browse Text Browse through a document ALT+CTRL+HOME 

Browse Text Go back to a page, bookmark, footnote, 
table, comment, graphic, or other 
location 

ALT+CTRL+Z 

Browse Text Go to a page, bookmark, footnote, 
table, comment, graphic, or other 
location 

CTRL+G 

Char Format Apply an underline CTRL+U 

Char Format Apply bold formatting CTRL+B 

Char Format Apply hidden text formatting CTRL+SHIFT+H 

Char Format Apply italic formatting CTRL+I 

Char Format Apply subscript formatting (automatic 
spacing) 

CTRL+EQUAL SIGN 

Char Format Apply superscript formatting (automatic 
spacing) 

CTRL+SHIFT+PLUS SIGN 

Char Format Change the case of letters SHIFT+F3 

Char Format Change the formatting of characters 
(Font command, Format menu) 

CTRL+D 

Char Format Change the selection to the Symbol font CTRL+SHIFT+Q 

Char Format Double-underline text CTRL+SHIFT+D 

Char Format Format letters as all capitals CTRL+SHIFT+A 

Char Format Format letters as small capitals CTRL+SHIFT+K 
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Category  Description  Keystrokes  

Char Format Remove manual character formatting CTRL+SPACEBAR 

Char Format Underline words but not spaces CTRL+SHIFT+W 

Common Create a nonbreaking hyphen CTRL+HYPHEN 

Common Create a nonbreaking space CTRL+SHIFT+SPACEBAR 

Common Decrease font size CTRL+SHIFT+< 

Common Increase font size CTRL+SHIFT+> 

Common Redo the last action CTRL+Y 

Common Remove character formatting CTRL+SPACEBAR 

Common Undo the last action CTRL+Z 

Copy/Move Copy selected text or object to 
clipboard 

CTRL+C 

Copy/Move Copy the header or footer used in the 
previous section of the document 

ALT+SHIFT+R 

Copy/Move Create AutoText ALT+F3 

Copy/Move Cut to the Spike CTRL+F3 

Copy/Move Display the Clipboard CTRL+C, CTRL+C 

Copy/Move Insert the contents of the Spike CTRL+SHIFT+F3 

Copy/Move Move text or graphics F2 (then move cursor and press ENTER) 

Copy/Move Paste the Spike contents CTRL+SHIFT+F3 

Copy/Move Paste the text or object from clipboard CTRL+V 

Create View Activate the ruler CTRL+SHIFT+F10 

Create View  Remove the document window split ALT+SHIFT+C 

Create View Split the document window ALT+CTRL+S 

Ctrl/func Choose the Move command (Control 
menu) 

CTRL+F7 

Ctrl/func Choose the Size command (document 
Control menu) 

CTRL+F8 

Delete Cut selected text to the Clipboard CTRL+X 

Delete Cut to the Spike CTRL+F3 

Delete Delete one character to the left BACKSPACE 

Delete Delete one character to the right  DELETE 

Delete Delete one word to the left  CTRL+BACKSPACE 

Delete Delete one word to the right  CTRL+DELETE 

Dialogs Cancel the command and close the 
dialog box 

ESC 
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Category  Description  Keystrokes  

Dialogs Close the selected list ESC (when a list is selected) 

Dialogs In the selected list, move to the next 
option that starts with the letter you type 

Letter key 

Dialogs Move between options in the selected 
list or between some options in a group 
of options  

Arrow keys 

Dialogs Move to the next option or option group TAB 

Dialogs Move to the previous option or option 
group 

SHIFT+TAB 

Dialogs Open the selected list ALT+DOWN ARROW (when a list is 
selected) 

Dialogs Perform the action assigned to the 
default button in the dialog box 

ENTER 

Dialogs Perform the action assigned to the 
selected button; select or clear the 
check box 

SPACEBAR 

Dialogs Select the option or select or clear the 
check box next to the letter underlined 
in the option name 

ALT+ letter key 

Dialogs Switch to the next tab in a dialog box CTRL+TAB or CTRL+PAGE DOWN 

Dialogs Switch to the previous tab in a dialog 
box 

CTRL+SHIFT+TAB or CTRL+PAGE UP 

Do/Undo Cancel an action ESC 

Do/Undo Redo or repeat an action CTRL+Y 

Do/Undo Undo an action CTRL+Z 

Do/Undo Undo the last action CTRL+Z  

Docs Close a document CTRL+W 

Docs Create a new document of the same 
type as the current or most recent 
document 

CTRL+N 

Docs Open a document CTRL+O 

Docs Remove the document window split ALT+SHIFT+C 

Docs Save a document CTRL+S 

Docs Split the document window ALT+CTRL+S 

Documents Choose the Open command (File 
menu) 

CTRL+F12 

Documents Choose the Print command (File menu) CTRL+SHIFT+F12 

Documents Choose the Print Preview command 
(File menu) 

CTRL+F2 



Microsoft Word Tips & Tricks  Info Sheet 

 

 - 9 -  

Category  Description  Keystrokes  

Documents Close a document CTRL+W 

Documents Create a new document of the same 
type as the current or most recent 
document 

CTRL+N 

Documents Open a document CTRL+O 

Documents Save a document CTRL+S 

extend Increase the size of a selection F8 (press once to select a word, twice to 
select a sentence, and so forth) 

extend Reduce the size of a selection SHIFT+F8 

extend Select the nearest character F8, and then press LEFT ARROW or 
RIGHT ARROW 

extend Turn extend mode off ESC 

extend Turn extend mode on F8 

fields A DATE field ALT+SHIFT+D 

fields A LISTNUM field ALT+CTRL+L 

fields A PAGE field ALT+SHIFT+P 

fields A TIME field ALT+SHIFT+T 

fields An empty field CTRL+F9 

Fields Go to the next field ALT+F1 

fields Go to the next field F11 

Fields Go to the previous field ALT+SHIFT+F1 

fields Go to the previous field SHIFT+F11 

Fields Insert an empty field CTRL+F9 

Fields Lock a field CTRL+F11 

fields Lock a field CTRL+F11 

Fields Run GOTOBUTTON or 
MACROBUTTON from the field that 
displays the field results  

ALT+SHIFT+F9 

fields Run GOTOBUTTON or 
MACROBUTTON from the field that 
displays the field results  

ALT+SHIFT+F9 

fields Switch between a field code and its 
result 

SHIFT+F9 

Fields Switch between all field codes and their 
results 

ALT+F9 

fields Switch between all field codes and their 
results 

ALT+F9 
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Category  Description  Keystrokes  

Fields Unlink a field CTRL+SHIFT+F9 

fields Unlink a field CTRL+SHIFT+F9 

Fields Unlock a field CTRL+SHIFT+F11 

fields Unlock a field CTRL+SHIFT+F11 

Fields Update linked information in a Word 
source document 

CTRL+SHIFT+F7 

fields Update linked information in a Word 
source document 

CTRL+SHIFT+F7 

fields Update selected fields F9 

find replace 
and browse 
text (dup?) 

Browse through a document ALT+CTRL+HOME 

find replace 
and browse 
text (dup?) 

Find text, formatting, and special items CTRL+F 

find replace 
and browse 
text (dup?) 

Go back to a page, bookmark, footnote, 
table, comment, graphic, or other 
location 

ALT+CTRL+Z 

find replace 
and browse 
text (dup?) 

Go to a page, bookmark, footnote, 
table, comment, graphic, or other 
location 

CTRL+G 

find replace 
and browse 
text (dup?) 

Repeat find (after closing Find and 
Replace window) 

ALT+CTRL+Y 

find replace 
and browse 
text (dup?) 

Replace text, specific formatting, and 
special items 

CTRL+H 

Find/Replace Find text, formatting, and special items CTRL+F 

Find/Replace Repeat find (after closing Find and 
Replace window) 

ALT+CTRL+Y 

Find/Replace Replace text, specific formatting, and 
special items 

CTRL+H 

fonts Change the font CTRL+SHIFT+F 

fonts Change the font size CTRL+SHIFT+P 

fonts Decrease the font size CTRL+SHIFT+< 

fonts Decrease the font size by 1 point CTRL+[ 

fonts Increase the font size CTRL+SHIFT+> 

fonts Increase the font size by 1 point CTRL+] 

formatting Show/Hide all formatting CTRL+SHIFT+8 (on alpha numeric keys) 
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Category  Description  Keystrokes  

Formatting Toggle Show/Hide CTRL+SHIFT+8 

FuncKeys Activate the menu bar F10 

FuncKeys Choose the Go To command (Edit 
menu) 

F5 

FuncKeys Choose the Save As command (File 
menu) 

F12 

FuncKeys Choose the Spelling command (Tools 
menu) 

F7 

FuncKeys Extend F8 

FuncKeys Get online Help or the Office Assistant F1 

FuncKeys Go to next pane or frame F6 

FuncKeys Go to the next field F11 

FuncKeys Insert an AutoText entry (after Word 
displays the entry) 

F3 

FuncKeys Move text or graphics F2 

FuncKeys Repeat the last action F4 

FuncKeys Update selected fields F9 

help Close the active Help window ALT+F4 

help Display the Options menu to access 
any Help toolbar command 

ALT+O 

help Display the program Control menu ALT+SPACEBAR 

help Move between the navigation pane and 
topic pane 

F6 

Help Asst Show the Assistant in a wizard, or turn 
off Help with the wizard.  

TAB (if a wizard is showing) to select 
Microsoft Word Help-, then the 
SPACEBAR to show the Assistant or turn 
off Help with the wizard 

help/asst Close an Assistant message or a tip. ESC 

help/asst Display the Assistant balloon. F1, if the Assistant is showing 

help/asst See more Help topics. ALT+DOWN ARROW 

help/asst See previous Help topics. ALT+UP ARROW 

help/asst Select a Help topic from the list the 
Assistant displays. 

ALT+number (ALT+1 is the first topic, 
ALT+2 is the second, and so on) 

help/navigate Open or close a selected book, or open 
a selected Help topic 

ENTER 

help/navigate Select the next book or Help topic DOWN ARROW 

help/navigate Select the previous book or Help topic UP ARROW 
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Category  Description  Keystrokes  

help/navigate Switch to the Answer Wizard tab ALT+A 

help/navigate Switch to the Contents tab ALT+C 

help/navigate Switch to the Index tab ALT+I 

help/navigate Switch to the next tab CTRL+TAB 

help/navigate Switch to the previous tab CTRL+SHIFT+TAB 

help/topics Activate a selected hyperlink ENTER 

help/topics Close a pop-up window ESC 

help/topics Copy the selected items to the 
Clipboard 

CTRL+C 

help/topics Go back to a Help topic you viewed 
previously 

ALT+LEFT ARROW 

help/topics Go forward to a Help topic you viewed 
previously 

ALT+RIGHT ARROW 

help/topics Go to the first or next hyperlink TAB 

help/topics Go to the last or previous hyperlink SHIFT+TAB 

help/topics Move to the beginning of a Help topic HOME 

help/topics Move to the end of a Help topic END 

help/topics Print the active Help topic CTRL+P 

help/topics Scroll toward the beginning of a Help 
topic 

UP ARROW 

help/topics Scroll toward the beginning of a Help 
topic in larger increments 

PAGE UP 

help/topics Scroll toward the end of a Help topic DOWN ARROW 

help/topics Scroll toward the end of a Help topic in 
larger increments 

PAGE DOWN 

help/topics Select the entire Help topic CTRL+A 

insert to table First cell in a column ALT+PAGE UP 

insert to table First cell in a row ALT+HOME 

insert to table Last cell in a column ALT+PAGE DOWN 

insert to table Last cell in a row ALT+END 

insert to table Next cell in a row TAB 

insert to table Next row DOWN ARROW 

insert to table Previous cell in a row SHIFT+TAB 

insert to table Previous row UP ARROW 

line spacing Add or remove one line space 
preceding a paragraph 

CTRL+0 (zero) 
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Category  Description  Keystrokes  

line spacing Double-space lines CTRL+2 

line spacing Set 1.5-line spacing CTRL+5 

line spacing Single-space lines CTRL+1 

Macros Display Microsoft Visual Basic code ALT+F11 

Macros Display Microsoft Visual Studio code ALT+SHIFT+F11 

Macros Run a macro ALT+F8 

mail merge Edit a mail-merge data document ALT+SHIFT+E 

mail merge Edit a mail-merge data document ALT+SHIFT+E 

mail merge Insert a merge field ALT+SHIFT+F 

mail merge Insert a merge field ALT+SHIFT+F 

mail merge Merge a document ALT+SHIFT+N 

mail merge Merge a document ALT+SHIFT+N 

mail merge Preview a mail merge ALT+SHIFT+K 

mail merge Preview a mail merge ALT+SHIFT+K 

mail merge Print the merged document ALT+SHIFT+M 

mail merge Print the merged document ALT+SHIFT+M 

menus Add a toolbar button to a menu. When 
you type this shortcut key and then click 
a toolbar button, Microsoft Word adds 
the button to the appropriate menu. For 

example, click Bullets   on the 
Formatting toolbar to add the Bullets 
command to the Format menu. 

ALT+CTRL+= 

menus Close the visible menu and submenu at 
the same time 

ALT 

menus Close the visible menu; or, with a 
submenu visible, close the submenu 
only 

ESC 

menus Customize the shortcut key for a menu 
command. When you type this shortcut 
key and then select a menu command, 
the Customize Keyboard dialog box 
opens so you can add, change, or 
remove the shortcut key. 

ALT+CTRL++ (plus key on numeric 
keypad) 

menus Make the menu bar active F10 

menus Remove a command from a menu. 
When you type this shortcut key and 
then select a menu command, the 
command is removed. You can add the 

ALT+CTRL+- (dash key) 
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Category  Description  Keystrokes  
menu command back to the menu if 
you change your mind. 

menus Select the first or last command on the 
menu or submenu 

HOME or END 

menus Select the menu to the left or right; or, 
with a submenu visible, switch between 
the main menu and the submenu 

LEFT ARROW or RIGHT ARROW 

menus Select the next or previous command 
on the menu or submenu  

DOWN ARROW or UP ARROW (with the 
menu or submenu displayed) 

menus Show the program icon menu (on the 
program title bar) 

ALT+SPACEBAR 

menus Show the shortcut menu SHIFT+F10 

move cursor Down one line DOWN ARROW 

move cursor Down one screen (scrolling) PAGE DOWN 

move cursor One cell to the left (in a table) SHIFT+TAB 

move cursor One cell to the right (in a table) TAB 

move cursor One character to the left LEFT ARROW 

move cursor One character to the right RIGHT ARROW 

move cursor One paragraph down CTRL+DOWN ARROW 

move cursor One paragraph up CTRL+UP ARROW 

move cursor One word to the left CTRL+LEFT ARROW 

move cursor One word to the right CTRL+RIGHT ARROW 

move cursor To a previous revision SHIFT+F5 

move cursor To the beginning of a document CTRL+HOME 

move cursor To the beginning of a line HOME 

move cursor To the end of a document CTRL+END 

move cursor To the end of a line END 

move cursor To the end of the window ALT+CTRL+PAGE DOWN 

move cursor To the location of the insertion point 
when the document was last closed 

SHIFT+F5 

move cursor To the top of the next page CTRL+PAGE DOWN 

move cursor To the top of the previous page CTRL+PAGE UP 

move cursor To the top of the window ALT+CTRL+PAGE UP 

move cursor Up one line UP ARROW 

move cursor Up one screen (scrolling) PAGE UP 

open/save Closes the dialog box and opens your ALT+3 
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Category  Description  Keystrokes  
World Wide Web search page (Search 

the Web button ) 

open/save Create a new subfolder in the open 

folder (Create New Folder button ) 

ALT+5 

open/save Delete the selected folder or file (Delete 

button ) 

ALT+4 

open/save Display the Open dialog box CTRL+F12 

open/save Display the Save As dialog box F12 

open/save 

Go to the previous folder ( ) 

ALT+1 

open/save Open the folder up one level from the 

open folder (Up One Level button 
) 

ALT+2 

open/save Show the Tools menu (Tools button) ALT+7 

open/save Switch between List, Details, 
Properties, and Preview views (click the 

arrow next to Views ) 

ALT+6 

open/save Update the files visible in the Open or 
Save As dialog box (File menu) 

F5 

outlines Collapse text under a heading ALT+SHIFT+MINUS SIGN 

outlines Collapse text under a heading ALT+SHIFT+MINUS SIGN 

outlines Demote a paragraph ALT+SHIFT+RIGHT ARROW 

outlines Demote a paragraph ALT+SHIFT+RIGHT ARROW 

outlines Demote to body text CTRL+SHIFT+N 

outlines Demote to body text CTRL+SHIFT+N 

outlines Expand or collapse all text or headings ALT+SHIFT+A or the asterisk (*) key on 
the numeric keypad 

outlines Expand or collapse all text or headings ALT+SHIFT+A or the asterisk (*) key on 
the numeric keypad 

outlines Expand text under a heading ALT+SHIFT+PLUS SIGN 

outlines Expand text under a heading ALT+SHIFT+PLUS SIGN 

outlines Hide or display character formatting The slash (/) key on the numeric keypad 

outlines Hide or display character formatting The slash (/) key on the numeric keypad 



Microsoft Word Tips & Tricks  Info Sheet 

 

 - 16 -  

Category  Description  Keystrokes  

outlines Move selected paragraphs down ALT+SHIFT+DOWN ARROW 

outlines Move selected paragraphs down ALT+SHIFT+DOWN ARROW 

outlines Move selected paragraphs up ALT+SHIFT+UP ARROW 

outlines Move selected paragraphs up ALT+SHIFT+UP ARROW 

outlines Promote a paragraph ALT+SHIFT+LEFT ARROW 

outlines Promote a paragraph ALT+SHIFT+LEFT ARROW 

outlines Show all headings up to Heading n ALT+SHIFT+n 

outlines Show all headings up to Heading n ALT+SHIFT+n 

outlines Show all headings with the Heading 1 
style 

ALT+SHIFT+1 

outlines Show all headings with the Heading 1 
style 

ALT+SHIFT+1 

outlines Show the first line of body text or all 
body text 

ALT+SHIFT+L 

outlines Show the first line of body text or all 
body text 

ALT+SHIFT+L 

preview/print Move around the preview page when 
zoomed in 

Arrow keys 

preview/print Move by one preview page when 
zoomed out 

PAGE UP or PAGE DOWN 

preview/print Move to the first preview page when 
zoomed out 

CTRL+HOME 

preview/print Move to the last preview page when 
zoomed out 

CTRL+END 

preview/print Print a document CTRL+P 

preview/print Switch in or out of Print Preview ALT+CTRL+I 

Program Close the window CTRL+F4 

Program Display Microsoft System Information CTRL+ALT+F1 

Program Go to the next window CTRL+F6 

Program Go to the previous window CTRL+SHIFT+F6 

Program Maximize the document window CTRL+F10 

Program Maximize the program window ALT+F10 

Program Quit Word ALT+F4 

Program Restore the document window size CTRL+F5 

Program Restore the program window size ALT+F5 

refs/notes Insert a footnote ALT+CTRL+F 
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Category  Description  Keystrokes  

refs/notes Insert an endnote ALT+CTRL+D 

refs/notes Mark a table of authorities entry ALT+SHIFT+I 

refs/notes Mark a table of contents entry ALT+SHIFT+O 

refs/notes Mark an index entry ALT+SHIFT+X 

review Go to the beginning of a comment HOME 

review Go to the beginning of the list of 
comments 

CTRL+HOME 

review Go to the end of a comment END 

review Go to the end of the list of comments CTRL+END 

review Insert a comment ALT+CTRL+M 

review Turn track changes on or off CTRL+SHIFT+E 

select One character to the left SHIFT+LEFT ARROW 

select One character to the right SHIFT+RIGHT ARROW 

select One line down SHIFT+DOWN ARROW 

select One line up SHIFT+UP ARROW 

select One screen down SHIFT+PAGE DOWN 

select One screen up SHIFT+PAGE UP 

select To a specific location in a document F8+arrow keys; press ESC to cancel 
selection mode 

select To a vertical block of text CTRL+SHIFT+F8, and then use the arrow 
keys; press ESC to cancel selection mode 

select To include the entire document CTRL+A 

select To the beginning of a document CTRL+SHIFT+HOME 

select To the beginning of a line SHIFT+HOME 

select To the beginning of a paragraph CTRL+SHIFT+UP ARROW 

select To the beginning of a word CTRL+SHIFT+LEFT ARROW 

select To the end of a document CTRL+SHIFT+END 

select To the end of a line SHIFT+END 

select To the end of a paragraph CTRL+SHIFT+DOWN ARROW 

select To the end of a window ALT+CTRL+SHIFT+PAGE DOWN 

select To the end of a word CTRL+SHIFT+RIGHT ARROW 

select/tbl Extend (or block) CTRL+SHIFT+F8, and then use the arrow 
keys; press ESC to cancel selection mode 

select/tbl Extend to adjacent cells Hold down SHIFT and press an arrow key 
repeatedly 
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select/tbl Reduce the selection size SHIFT+F8 

select/tbl Select a column Click in the column's top or bottom cell. 
Hold down SHIFT and press the UP 
ARROW or DOWN ARROW key 
repeatedly 

select/tbl Select an entire table ALT+5 on the numeric keypad (with NUM 
LOCK off) 

select/tbl Select the next cell's contents TAB 

select/tbl Select the preceding cell's contents SHIFT+TAB 

Selection Extend or block (then press an arrow 
key) 

CTRL+SHIFT+F8 

shft/func Change the case of letters SHIFT+F3 

shft/func Choose the Save command (File menu) SHIFT+F12 

shft/func Choose the Thesaurus command 
(Tools menu, Language submenu) 

SHIFT+F7 

shft/func Copy text SHIFT+F2 

shft/func Display a shortcut menu SHIFT+F10 

shft/func Go to the previous field SHIFT+F11 

shft/func Go to the previous pane or frame SHIFT+F6 

shft/func Move to a previous revision SHIFT+F5 

shft/func Repeat a Find or Go To action SHIFT+F4 

shft/func Shrink a selection SHIFT+F8 

shft/func Start context-sensitive Help or reveal 
formatting 

SHIFT+F1 

shft/func Switch between a field code and its 
result 

SHIFT+F9 

special chars A column break CTRL+SHIFT+ENTER 

special chars A field CTRL+F9 

special chars A line break SHIFT+ENTER 

special chars A nonbreaking hyphen CTRL+SHIFT+HYPHEN 

special chars A nonbreaking space CTRL+SHIFT+SPACEBAR 

special chars A page break CTRL+ENTER 

special chars An AutoText entry ENTER (after typing the first few 
characters of the AutoText entry name 
and when the ScreenTip appears) 

special chars An ellipsis ALT+CTRL+period 

special chars An optional hyphen CTRL+HYPHEN 
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special chars The copyright symbol ALT+CTRL+C 

special chars The registered trademark symbol ALT+CTRL+R 

special chars The trademark symbol ALT+CTRL+T 

Spelling Find the next misspelling or 
grammatical error. The Check spelling 
as you type check box must be selected 
(Tools menu, Options dialog box, 
Spelling & Grammar tab). 

ALT+F7 

styles Apply a style  CTRL+SHIFT+S 

styles Apply the Heading 1 style ALT+CTRL+1 

styles Apply the Heading 2 style ALT+CTRL+2 

styles Apply the Heading 3 style ALT+CTRL+3 

styles Apply the List style CTRL+SHIFT+L 

styles Apply the Normal style CTRL+SHIFT+N 

styles Start AutoFormat ALT+CTRL+K 

tables First cell in a column ALT+PAGE UP 

tables First cell in a row ALT+HOME 

tables Last cell in a column ALT+PAGE DOWN 

tables Last cell in a row ALT+END 

tables Next cell in a row TAB 

tables Next row DOWN ARROW 

tables Previous cell in a row SHIFT+TAB 

tables Previous row UP ARROW 

text format Copy formats CTRL+SHIFT+C 

text format Display nonprinting characters CTRL+SHIFT+* (asterisk) 

text format Paste formats CTRL+SHIFT+V 

text format Review text formatting SHIFT+F1 (then click the text whose 
formatting you want to review) 

textbox Move one character to the left or right LEFT ARROW or RIGHT ARROW 

textbox Move one word to the left or right CTRL+LEFT ARROW or CTRL+RIGHT 
ARROW 

textbox Move to the beginning of the line HOME 

textbox Move to the end of the line END 

textbox Select from the insertion point to the 
beginning of the line 

SHIFT+HOME 

textbox Select from the insertion point to the SHIFT+END 
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end of the line 

textbox Select or cancel the selection of one 
character to the left 

SHIFT+LEFT ARROW 

textbox Select or cancel the selection of one 
character to the right  

SHIFT+RIGHT ARROW 

textbox Select or cancel the selection of one 
word to the left 

CTRL+SHIFT+LEFT ARROW 

textbox Select or cancel the selection of one 
word to the right 

CTRL+SHIFT+RIGHT ARROW 

toolbars Enter text in a text box ENTER (when the text box is selected) 

toolbars Make the menu bar active F10 

toolbars Move through options in a menu or 
drop-down list 

Arrow keys 

toolbars Open the menu ENTER (when a menu on a toolbar is 
selected) 

toolbars Perform the action assigned to a button  ENTER (when a button is selected) 

toolbars Select the next or previous button or 
menu on the toolbar 

TAB or SHIFT+TAB (when a toolbar is 
active) 

toolbars Select the next or previous toolbar CTRL+TAB or CTRL+SHIFT+TAB 

toolbars Select the option you want ENTER (when a drop-down list box is 
selected) 

undo/redo Cancel an action ESC 

undo/redo Redo or repeat an action CTRL+Y 

undo/redo Undo an action CTRL+Z 

views Move between a master document and 
its subdocuments 

CTRL+\ 

views Switch to normal view ALT+CTRL+N 

views Switch to outline view ALT+CTRL+O 

views Switch to print layout view ALT+CTRL+P 

views (dup?) Move between a master document and 
its subdocuments 

CTRL+\ 

views (dup?) Switch to normal view ALT+CTRL+N 

views (dup?) Switch to outline view ALT+CTRL+O 

views (dup?) Switch to print layout view ALT+CTRL+P 

web page Go back one page ALT+LEFT ARROW 

web page Go forward one page ALT+RIGHT ARROW 

web page Insert a hyperlink CTRL+K 
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web page Refresh F9 

windows Carry out the Move command when the 
document window isn't maximized 
(document icon menu, menu bar) 

CTRL+F7, press arrow keys, and then 
press ENTER 

windows Carry out the Size command when the 
document window isn't maximized 
(document icon menu, menu bar) 

CTRL+F8, press arrow keys, and then 
press ENTER 

windows Close the active document window CTRL+W 

windows Maximize the document window or 
restore the window to its previous size 
and location 

CTRL+F10 

windows Restore the size of the active document 
window after you've maximized the 
window 

CTRL+F5 

windows Show the Microsoft Windows Start 
menu 

CTRL+ESC 

windows Switch to the next program or Microsoft 
Word document window 

ALT+TAB 

windows Switch to the next Word document 
window 

CTRL+F6 

windows Switch to the previous program or Word 
document window 

ALT+SHIFT+TAB 

windows Switch to the previous Word document 
window  

CTRL+SHIFT+F6 

word email Check the names on the To, Cc and 
Bcc lines against the Address Book 

ALT+K 

word email Create a message flag CTRL+SHIFT+G 

word email Go to the Subject field ALT+J 

word email Open the Address Book CTRL+SHIFT+B 

word email Open the Address Book in the Bcc field ALT+B 

word email Open the Address Book in the To field ALT+. (period) 

word email Open the Microsoft Outlook Message 
Options dialog box (in a message, View 
menu, Options command) 

ALT+P 

word email Opens the Address Book in the Cc field ALT+C 

word email Select the next box in the e-mail header 
or the body of the document or 
message when the last box in the e-
mail header is active 

TAB 

word email Select the previous field or button in the 
e-mail header 

SHIFT+TAB 
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word email Send the active document or message ALT+S 

 
 

 


